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EN 3INTRODUCTION
You can find the latest information (in English) on the provided software program at our world wide web 
server at http://www.jvc-victor.co.jp/english/index-e.html

● Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries.

● Macintosh is a registered trademark of Apple Computer, Inc.
● Other product and company names included in this instruction manual are trademarks and/or registered 

trademarks of their respective holders.

This document consists of the following sections.
Before use, please read “SOFTWARE INSTALLATION AND USB CONNECTION GUIDE” for preparation.

� Digital Photo Navigator
This section explains how to load still images into the album of the Digital Photo Navigator and how to 
handle still images using the Digital Photo Navigator software. You can send still images by e-mail and store 
an album as a web page.

� Troubleshooting

CAUTION:
● Operate this equipment according to the operating procedures described in this manual.
● Use only the provided CD-ROM. Never use any other CD-ROM to run this software.
● Do not attempt to modify this software.
● Changes or modifications not approved by JVC could void user’s authority to operate the equipment.

ATTENTION:
When connecting a USB cable to PC
● Never switch the recording/playback mode on the camera when the USB cable is connected. It may 

cause the camera not to be recognized by the PC. If it occurs, confirm that the PC is not accessing the 
camera, then disconnect the USB cable and connect it again.

● Never turn on or off the camera when the USB cable is connected. It may cause malfunctions of the PC.

How to handle a CD-ROM
● Take care not to soil or scratch the mirror surface (opposite to the printed surface). Do not write anything 

or put a sticker on either the front or back surface. If the CD-ROM gets dirty, gently wipe it with a soft 
cloth outward from the center hole.

● Do not use conventional disc cleaners or cleaning spray.
● Do not bend the CD-ROM or touch its mirror surface.
● Do not store your CD-ROM in a dusty, hot or humid environment. Keep it away from direct sunlight.

Reading this document
Download from Www.Somanuals.com. All Manuals Search And Download.
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The following symbols are used in this document.

NOTE:
Indicates problems that could occur while using these softwares, phenomena that may appear to be a 
problem, limitations on the use of these softwares, or other information that is useful to know.

�
Indicates pages where related information can be found.

CONTINUED ON NEXT PAGE
Indicates that the explanation continues on the next page.

Under copyright law, any material that you may edit with this software cannot be used for any purpose other 
than your own personal enjoyment without the permission of the copyright holder. Note that this restriction 
applies when dubbing tracks from a CD as background music for your own movies.

Meanings of symbols

Copyrights
Download from Www.Somanuals.com. All Manuals Search And Download.
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EN 5Digital Photo Navigator

DIGITAL PHOTO NAVIGATOR
Send your favorite videos and pictures by e-mail
Everyone has recording media containing videos and pictures that they never get to show to anyone.
No matter how wonderful, the only people that got to see them were families and guests, because there was 
no convenient way to show them except in your own home on the TV. Friends and relatives who live far away 
had no way of viewing them. And you don’t want to throw those recording media away because they hold 
treasured memories.
Now you can solve all of these problems with a PC. By using a USB cable to connect a camera to a PC, you 
can copy video files from the camera to the PC. You can then send the files to anyone as an e-mail 
attachment.

Loading Still Images
The Digital Photo Navigator software allows you to store and view still images in a photo album format.

Playing Back and Handling Images
You can send still image files as an e-mail attachment and store an album as a web page.

Create a virtual album
If you have a lot of image files with similar names, it can be hard to remember which file contains which 
image.
You can use this software to display these images on your PC just as if you had pasted them in a photo album. 
Because you can scan through these images just as if you were flipping through a photo album, you can 
quickly find a specific image that you want to send through e-mail, for example.

Capabilities
M4S5_Soft_04PhotoNavi.fm Page 5
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6 EN ADDING STILL IMAGES TO AN ALBUM
You can use Digital Photo Navigator to create an album that contains a collection of still images.

1 Click [Start], go to [All Programs] or [Programs]– [Digital Photo Navigator], and then click 
[Digital Photo Navigator 1.0].

Digital Photo Navigator starts.
● Close any other programs running on the PC.
● Disable any programs that run in the background, such as screen savers, e-mail applications, virus 

checkers, schedulers, etc.
● Turn off file and printer sharing.

2 Click [Import].

3 Click [Image].
The [Open] dialog box appears.

4 Open the folder that contains the desired still images.

● Select the folder of the still images copied to the PC and click [Open].
The still image files appear in the window.

5 Select the desired still image files and click [Open]. The still images are added to the right-
hand side of the Digital Photo Navigator window.
● You may select more than one file.
● You can also add files by dragging and dropping them in the Digital Photo Navigator window.

CONTINUED ON NEXT PAGE
M5S7_Soft_04PhotoNavi.fm Page 6
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EN 7ADDING STILL IMAGES TO AN ALBUM (cont.)
6 Add additional still images as desired by repeating steps 3 – 5.

NOTES:
● When loading images from a recording medium, never disconnect the USB cable while the message 

[ACCESSING FILES] is displayed in the camera’s LCD monitor.
● Digital Photo Navigator can only load still images. Digital Photo Navigator cannot load video files.

7 Click [Export].

8 Click [Album].
The [Save As] dialog box appears.

9 Specify the location where you want to save the album, enter the file name of the album, 
and then click [Save].
The album is saved.
● If you save an album for the first time after the software installation, a message appears and asks if you 

want to register the association of the file extension name “jia”. Then, click [Yes].
● To exit Digital Photo Navigator, refer to “EXITING DIGITAL PHOTO NAVIGATOR” (See below).

EXITING DIGITAL PHOTO NAVIGATOR

1 Click the [File] menu and then click [Exit].
● If you have already saved an album, a confirmation message appears. Then, go to step 2.
● If you have not saved an album after loading still images, a confirmation message appears.
To save an album, click [Yes]. The [Save As] dialog box appears. Specify the location where you want to 
save the album, enter the file name of the album, and then click [Save]. A confirmation message 
appears. Then, go to step 2.
To exit Digital Photo Navigator without saving an album, click [No]. A confirmation message appears. 
Then, go to step 2.

2 Click [Yes].
Digital Photo Navigator closes.
M4S5_Soft_04PhotoNavi.fm Page 7
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8 EN LOADING AN ALBUM
1 Start Digital Photo Navigator. (� pg. 6)
2 Click [Import].

3 Click [Album].
The [Open] dialog box appears.

4 Open the folder where the album was saved.

5 Click the desired album file, and then click [Open].
The contents of the album are displayed in the right-hand side of the Digital Photo Navigator window.

6 Click [Export].

NOTES:
● You can also open the album file by dragging and dropping it in the Digital Photo Navigator window.
● If an album is currently open, a confirmation message appears.

• If you want to open the newly selected album instead of the one already opened, click [Yes]. If you have 
not saved the album already opened, a confirmation message appears. If you want to save the album, 
click [Yes]. If you do not want to save the album, click [No].

• If you want to add still images from the newly selected album to the album already opened, click [No].
M5S7_Soft_04PhotoNavi.fm Page 8

Download from Www.Somanuals.com. All Manuals Search And Download.



Master Page: Right-Heading0

M4S5_Soft.book  Page 9  Friday, August 20, 2004  12:00 PM
EN 9DISPLAYING STILL IMAGES
Displaying a selected still image
You can select for display any of the still images that are displayed in the right-hand side of the Digital Photo 
Navigator window.

1 Double-click the still image to be displayed.
The [Image Viewer] window appears, and the selected image is displayed.

Displaying a series of images
To display a series of images in “slide show” fashion, click the  button in the [Image Viewer] window. You 
can also move through the images manually in either direction by clicking the  and  buttons.

To adjust the speed of the slide show, right-click the [Image Viewer] window and then, in the menu that 
appears, click [Slide show] – [Setting Interval Time]. Set the length of the interval (in seconds), and then click 
[OK].

NOTE:
The interval for a slide show is a little longer than the setting because of display processing time.

Stop slide show

First image Last image

Next image

Start slide show

Previous image
M4S5_Soft_04PhotoNavi.fm Page 9
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Enlarging and reducing images
The following procedure describes how to change the display size of a still image.

1 Drag the corner of the [Image Viewer] window to change the size of the window to the 
desired display size.

2 Right-click the [Image Viewer] window and then, in the 
menu that appears, click [Zoom] – [Auto].
The size of the still image is automatically enlarged or reduced 
to fit the window, and the display magnification (enlargement/
reduction percentage) indicated in the title bar of the window 
changes accordingly.

Other enlargement/reduction functions
In addition to adjusting the size of the image to the size of the 
window, the display size of a still image can also be changed by the 
methods described below. Each of these functions can be selected by 
right-clicking the [Image Viewer] window.
● [Zoom] – [Real Size]: Displays the image in its original size 

(display magnification of 100%).
● [Zoom] – [Zoom In]: Displays the image at twice its current display magnification (up to 400%).
● [Zoom] – [Zoom Out]: Displays the image at half its current display magnification (up to 20%).

Display magnification
M4S5_Soft_04PhotoNavi.fm Page 10
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EN 11ORGANIZING ALBUMS
Whenever necessary, you can delete or copy still images that you have added to an album. The procedure 
described below only affects the still image in the album. It does not affect the original file of the still image 
that was added to the album.

To delete or copy multiple still Images at once, select them in advance. You can also select all still images in 
the album.

Selecting still images continuously
Click still images while holding down the Shift key.

If you click one still image while holding down the Shift key, the images of smaller numbers are selected as 
well.

Selecting still images one by one
Click still images while holding down the Ctrl key.

Selecting all of the still images
Click [Select All] in the [Edit] menu.

Selecting multiple still images

Shift + Click

Click

Ctrl + Click
M4S5_Soft_04PhotoNavi.fm Page 11
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1 Click the still image that you want to delete, and then click [Delete] in the [Edit] menu.
A confirmation message appears.

2 Click [Yes].
The selected still images are deleted.

1 Click the still image that you want to copy, and then click [Copy] in the [Edit] menu.
2 Click the image that is located right after the insertion point.

● To add the images at the end of the album, click the blank space in the right-hand side of the window.

3 Click [Paste] in the [Edit] menu.
The copied still images are inserted right before the selected image.

NOTE:
You can delete, copy or paste an image also by right-clicking it.

Deleting unnecessary still images

Copying still images

Insertion point
M4S5_Soft_04PhotoNavi.fm Page 12
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EN 13SENDING IMAGES FROM AN ALBUM IN E-MAIL
Still images in an album can be sent as an e-mail attachment.

Preparation: Before using the [E-Mail] function
If you use the Internet Explorer, be sure to use the version 5.5 or later.
When installing the Internet Explorer, select a typical set of components.

1 Click the still image that you want to send, and then click [E-Mail].

The new message window in your e-mail program appears, and the still image file is registered as an 
attachment.

NOTES:
● Depending on an e-mail software, a new message window may not open when the [E-Mail] button is 

clicked.
● Depending on an e-mail software, settings such as “Set as MAPI client” or “Used by MAPI application” are 

necessary.
● The maximum number of messages that can be created at once is three.
M4S5_Soft_04PhotoNavi.fm Page 13
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14 EN CREATING A WEB PAGE
You can save the contents of an album in HTML format. This is useful in the following instances:

When creating a web page: You can create a web page that features a collection of photos.
When distributing an album: You can create an album in a format that can be displayed by a web 

browser. This is useful if you want to distribute the album on CD-R, etc.

1 Select the still images that you want to save in HTML format.

● To select more than one still image, hold down the Shift key or the Ctrl key while clicking the images.
● To select all of the still images, click [Select All] in the [Edit] menu.

2 Click [Web Page].
The [Web Page] dialog box appears.

3 Set the following items when necessary.
● [Title]: This will be the title of the web page.
● [Font Color]: This specifies the color of the title text.
● [Back Color]: This specifies the background color of the web page. (Specify a color other than the font 

color.)
● [Limit horizontal size of the images]: This allows you to specify the maximum width of the image 

when displayed by a web browser. (Set the number of pixels much smaller than the width of the PC’s 
display.)

CONTINUED ON NEXT PAGE
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4 Click [OK], specify the save location, and then click [Save].
The HTML file is saved, and a folder with the same name is saved at the same time. A confirmation 
message appears next, asking whether to display the web page.

5 Click [Yes].
The web browser opens, and the HTML file that was created is displayed.

● Click on an image on the web page to enlarge it.

What Next?
You can also view an HTML file through the web browser by double-clicking the HTML file. You can upload 
the HTML file to your home page, or save it on a CD-R or some other media and distribute it.
Always handle HTML files and folders as a set. Without its folder, an HTML file cannot be viewed by a web 
browser.

NOTES:
● For more details on how to create a home page, consult your Internet service provider’s web site or one of 

the many reference books available.
● Use third-party home page creation software or similar software to edit HTML files.
M4S5_Soft_04PhotoNavi.fm Page 15
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16 EN CHANGING THE IMAGE SIZE OR PICTURE QUALITY
This procedure describes how to change the size of an image that has been loaded into Digital Photo 
Navigator. This procedure is used to reduce the size of an image that is being attached to an e-mail or saved 
in an album.

1 Select the still image to be changed.

● To select more than one still image, hold down the Shift key or the Ctrl key while clicking the images.
● To select all of the still images, click [Select All] in the [Edit] menu.

2 Click [Change Format].
The [Image Format] dialog box appears.

3 Select one of the following items:

● [Expansion/Reduction]: Set any desired image size in the [Width] and [Height] fields. If the [Keep 
aspect ratio] check box is not selected (off), both [Width] and [Height] fields can be changed.

● [Generic Size]: Select the size from a list of generic sizes.
● [PDA Size]: This is an image size (160 x 160) that can be displayed on most PDAs.

4 Click [OK].
● If you select more than one still image in step 1, a confirmation message appears.
• If you want to apply the same format to all images, click [Yes].
• If you do not want to apply the same format, click [No]. The first image is saved. Then, select the 

image size for each image.
The image size is changed to the selected size. If the vertical-to-horizontal ratio was changed, the blank 
spaces are shown as black.

Changing the image size
M4S5_Soft_04PhotoNavi.fm Page 16
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In addition to changing the size of an image, it is also possible to rotate images, change or correct the quality 
of an image, and change the file format of an image. The role of each setting is described in more detail 
below.

[90 degrees Rotation]
If you hold the camera sideways when recording an 
image, you can create an image that is taller than it is 
wide. Because this still image will be displayed sideways, 
use this function to rotate the image 90 degrees to the 
portrait orientation.
[None]: No correction
[Clockwise]: Rotates the image 90 degrees clockwise.
[Counterclockwise]: Rotates the image 90 degrees 
counterclockwise.

[Image Correction (DV)]
This setting is not available.

[Format]
You can select the file format of an image.
[JPEG]: This is the format that is typically used on the Internet. This format has a smaller file size.
[BITMAP]: This is the standard Windows® image format (BMP). Many applications can use this format.

[JPEG Quality]
This setting is available when JPEG was selected in the [Format] field. Moving the slider to the left makes the 
file smaller. Moving the slider to the right results in less deterioration in the image quality. The initial setting is 
75.

NOTES:
● When [JPEG] is selected in the [Format] field, the quality of the image deteriorates slightly each time that 

[OK] is clicked for the [Image Format] dialog box. To restore the original image quality, reload the original 
still image file.

● To confirm the file size, right-click the still image and then select [Properties].

Changing the picture quality, etc.
M4S5_Soft_04PhotoNavi.fm Page 17
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18 EN RETRIEVING STILL IMAGES FROM AN ALBUM
You can retrieve still images from an album and save them as a file.

1 Select the still image to be retrieved.

● To select more than one still image, hold down the Shift key or the Ctrl key while clicking the images.
● To select all of the still images, click [Select All] in the [Edit] menu.

2 Click [Image].
The [Image Format] dialog box appears.

3 Change the image format as desired. (� pg. 16) Then, click [OK].

● At this point, you can change the image size and picture quality as desired. (� pg. 16)
The [Save As] dialog box appears.

4 Specify the location where you want to save the file, enter the file name, and then click 
[Save].
The image file is saved.
● If you select more than one still image in step 1, a confirmation message appears.
• If you want to save all images with the same image format and their default name, click [Yes]. The 

[Auto Save Result] dialog box appears. Then, click [OK].
• If you want to set the image format and enter file name for each image, click [No]. The first image is 

saved. The [Image Format] dialog box appears for the second image. Repeat steps 3 and 4 as many 
times as necessary.
M4S5_Soft_04PhotoNavi.fm Page 18
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EN 19CREATING A LIST OF STILL IMAGES
You can arrange multiple still images together and save them in a single still image file.

1 Holding down the Shift key or the Ctrl key, select the still images that are to be added to 
the list.

2 Click [Multi Image].
The [Multi Image] dialog box appears.

3 Select the number of partitions.

● Either 4, 9, or 16 partitions may be selected.

4 Click [Back Color], select the color for the overall background, and then click [OK].

5 Change the positions of the still images as desired.

● Deleting an image: Right-click the still image and then select [Delete].
● Adding an image: Drag an image from the right-hand side of the Digital Photo Navigator window to 

the [Multi Image] dialog box.

CONTINUED ON NEXT PAGE
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6 Click [Save].
The [Image Format] dialog box appears.

7 Change the image format as desired. (� pg. 16) Then, click [OK].

● At this point, you can change the image size and picture quality as desired. (� pg. 16)
The [Save As] dialog box appears.

8 Specify the location where you want to save the file, enter the file name, and then click 
[Save].
The still image list file is saved.
M4S5_Soft_04PhotoNavi.fm Page 20
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EN 21CREATING A SLIDE SHOW OR AN ANIMATION
You can create a slide show or an animation in which a series of still images are displayed, and then save 
those images as a movie file (extension “.avi”).
[Slide Show]: Still images are displayed for several seconds each, one at a time.
[Animation]: Several still images are displayed per second. We recommend that you select a series of still 
images that create the appearance of continuous movement. This mode is also suitable for playing back still 
images that was recorded with Interval Shooting function.

1 Holding down the Shift key or the Ctrl key, select several still images.

2 Click [Movie].
The [Movie Settings] dialog box appears.

3 Select either [Slide Show] or [Animation], which ever is desired.

● For a slide show, set the length of the interval (in seconds).
● For an animation, set the number of displayed frames (images) per second.

4 Set the following items when necessary.
● [Image Size]: Select the size of the movie file.
● [Compressor]: Select the type of compressor.
● [Back Color]: This item is used if the aspect ratio of the images is not 4:3.

5 Click [OK].
The [Save As] dialog box appears.

6 Specify the location where you want to save the file, enter the file name, and then click 
[Save].
● The file name can be changed.
The movie file is saved, and a confirmation message that asks if you want to play the movie now 
appears.

7 Click [Yes].
The movie file is played back.

NOTES:
● If you change the [Compressor] item, make sure that the playback system supports that type of compressor.
● Depending on the selected type for [Compressor], a movie file cannot be created.
● In some cases, the settings in the [Video Compression] dialog box are invalid.
Download from Www.Somanuals.com. All Manuals Search And Download.
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22 EN TROUBLESHOOTING
SYMPTOM CORRECTIVE ACTION

Although the USB cable is 
connected, PC operating system 
does not recognize the recording 
medium in the camera or the 
camera.

•Make sure that the AC Adapter is connected to the camera and that 
the power is on.

•Make sure that the USB cable is connected securely. (� 
“SOFTWARE INSTALLATION AND USB CONNECTION GUIDE”)

•Either use a USB hub that has its own power supply, or connect the 
USB cable directly to the PC’s USB connector.

•Windows® might not be recognizing the USB connector. Make sure 
that the USB (Universal Serial Bus) controller within [Device 
Manager] is usable.

Cannot copy or save files. •Make sure that there is enough free space available in the drive 
where you are trying to copy or save a file.

•Make sure that the drive where you are trying to copy or save a file is 
not write-protected.

•Make sure that a file with the same name does not already exist 
where you are trying to copy or save a file.

•Either use a USB hub that has its own power supply, or connect the 
USB cable directly to the PC’s USB connector.

Cannot load still images into Digital 
Photo Navigator.

•Sometimes the format of the still image data prevents it from being 
loaded into Digital Photo Navigator. Use other graphics drawing or 
processing software to convert the file to either bitmap format or 
JPEG format.

•Make sure that there is enough free space available in the drive in 
which Digital Photo Navigator is installed.

Still images have a mosaic 
appearance.

•When a small image is loaded and enlarged, it will take on a mosaic 
appearance. (� pg. 10)

•If an image is saved with a lower JPEG quality or if the format of the 
image is changed, it will take on a mosaic appearance. (� pg. 17)

The colors displayed on the PC are 
odd.

•Images will not be displayed correctly if the display is set for 256-
color (or fewer) display.

[Found New Hardware Wizard] 
screen appears. (Windows® XP)

•Disconnect the cable, then connect the cable used when installing 
the driver.

The created date of the file is not 
displayed correctly on the 
information display panel.

•The created date is not displayed correctly if the date is not set on 
the camera.

NOTE:
When using a laptop PC, operation may be interrupted by a warning when the battery is nearly exhausted.
● If there is software which monitors the status of the battery running in the [StartUp] folder…

Close the application, or delete/move its icon from the [StartUp] folder and reboot your PC.
● If you are using your PC’s power management function…

Right-click the [My Computer] icon, then select [Properties]–[System Properties]–[Device Manager]–
[System Devices]–[Advanced Power Management Support]. Deactivate the power management function.
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